
President’s Message

Dear Fellow Women Artists,  

Sometimes itʼs good to shake things 
up a little and make changes. When I 
paint alone in my studio I spend a lot 
of quality time with myself. But when I 
take a workshop, I get to spend time with other painters. And 
thatʼs an entirely different kind of quality time.
     
I was at the Palm Springs Art Museum for a week at the end of March 
and I rediscovered how valuable it is to share other artistsʼ energy and 
vision. Not to mention how great it is to have a marvelous instructor 
guiding your hand. Going with two special friends was also a joy and 
made the non-studio time extra wonderful. The joy of unloading all 

your supplies on Monday at 9 and not having to move the paints, brushes, canvas, papers, etc. until 
Friday afternoon is only exceeded by the fact that you know each evening that you can come back 
tomorrow and repeat the wonder. And the variety of art being made in the workshop was awesome… 
oil landscapes, pastel abstracts, figurative mazes, Matisse-like imagery and, of course, our collages.  

The desert was also amazing – everything blooming! And if you havenʼt been to the Palm Springs area 
in a while, I highly recommend you visit Sunnylands in Rancho Mirage. The home of the Annenbergs, 
it served as a meeting place for presidents, diplomats and entertainment stars. There is an amazing new 
conference center and garden that is beyond beautiful and even if you canʼt visit the house (tickets are 
very limited but available online if youʼre lucky), acres of gardens alone are worth spending hours 
wandering through.

Hereʼs wishing you a wonderful Spring and a little shaking up as well.        Susan Rosman, Co-president

And let me add, congratulations are in order to our WPW members reaching Active Status: Mardi de 
Veuve Alexis, Lucie Hinden, and Bonnie Sue Schwartz.                             Lynn Gadal, Co-president WPW
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ARTIST LICENSE PLATE FRAMES!
Together we can market the website 
and declare our place in the world! 

GET YOURS AT THE NEXT LUNCHEON • Thursday, May 10
Custom Frame $6.00 each • Check or cash accepted

To order by mail, send a check for $11.30 (includes postage) 
made out to Women Painters West for one frame, $17.30 for two to: 

Mara Thompson • 734 Cedar Street, Apt A 
Santa Monica,  CA  90405

visit us at www.womenpainterswest.org

http://www.womenpainterswest.org/
http://www.womenpainterswest.org/


PROGRAM NEWS

Elizabeth Patterson, colored pencil artist
April 2012 Featured Luncheon Speaker

Elizabeth Patterson, colored pencil artist, was 
the featured speaker at our April luncheon 
meeting. Her openness in sharing her difficult 
path to becoming a full time artist with exclusive 
gallery representation after a devastating hand 
injury was heartwarming. The masterful 
drawings from her "Rainscapes" series and 
discussion and images of her colored pencil 
technique was of great interest to the members 
in attendance. WPW

Betzi Stein
Program Chair
betzi@betzistein.com  310 202-0474
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Great Thanks to all the Newsletter 
Staff Contributors

Managing and layout editor: Ken Marsh
Feature articles: Susan Rosman; Betzi Stein; 

Diane Karpel; Donna Buch
Photos: Betzi Stein

Mailing: Mathilde & Dan Lombard

Scholarship Awards Presentations

Please join us to hear and see the students’ artwork, May 10th at our luncheon. The Scholarship 
Committee met at Otis Art Institute on Friday, March 30 to select 6 students who will receive their 
awards at our WPW Awards luncheon. Barbara Frankel, Scholarship Chair, Lynn Gadal, WPW 
co-president, and past presidents, Nancy Goodman Lawrence, June Phelps, Lorraine Strieby, 
and Loraine Veeck were the jurors of selection. WPW

 Julie Margalit Lavee passed away March 14, 2012 at the age of 89. For many years, she was 
 an Active member of Women Painters West. She was an accomplished artist.  When asked 

what to look for in her abstract painting, she explained, “Abstract 
images are not meant to be subject to verbal descriptions. But 
the emotions and memories evoked on both sides make the 
communication possible.” WPW

visit us at www.womenpainterswest.org
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MEMBERS’ NEWS
Nancy Lawrence

         
Pat Dispenziere's painting, "Tallinn," 
was juried into the “Western Colorado 
Watercolor Society 20th Annual Watercolor 
Exhibition,” Grand Junction Art Center, CO, 
and won the Liquitex Award. "Scavengers" 
was juried into the “Watercolor Art Society-
Houston 35th International Exhibition” and 
won a Merit Award. The show qualifies 
her for signature membership in WAS-H. 
"Window Shopping in France" won an 
Honorable Mention in the “Carlsbad 
Oceanside Art League Annual Members 
Show.” "Family Outing" was juried into 
the “Southwestern Artists' Association 
11th Annual Exhibition.”

Carole Gillin has 3 paintings at La Galeria 
Gitana through June 15. She also has two 
paintings in “Dreams on Canvas,” one of 
which was selected as a feature piece. 
Both pieces will be shown at the Four 
Seasons Hotel in Westlake from May 
4 to 31. 

Andrea Rubin Kichaven and Erella 
Teitler were two of the featured artists in 
“Hadassah Through The Eyes of the Artist,” 
Zena & Pauline Gatov Gallery, Alpert 
Jewish Community Center, Long Beach.

Pat Salmonsʼ painting, “Space Flight,” is 
in a juried exhibit at the Schomburg Gallery, 
which runs through April 25. The show was 
given a full-page feature in the Palisades 
Post, and Pat was one of the four artists 
profiled. 

Virginia Wyper was juried into the “NWS 
Membership Exhibition,” NWS Building, 
San Pedro. The exhibit runs through 
May 13. WPW

To submit your art events, send your information 
to Nancy Lawrence @ tearmyartout@mac.com. 

All submissions must be sent no later than 
the 10th of each month.
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MEMBERSHIP OPPORTUNITIES

visit us at www.womenpainterswest.org

Jury Day is Thursday, May 3, 2012, St. Bedes, 
good luck to all applicants!

Helpers needed on Jury Day! Please contact:
Susie Gesundheit, 818-216-8091 
soozworm@aol.com
 
Membership Chair:
Diane Karpel, Djk62@aol.com
Committee:
Susie Gesundheit, soozworm@aol.com
Harriett Lahana, Harriett.Lahana@gmail.com

mailto:tearmyartout@mac.com
mailto:tearmyartout@mac.com
http://www.womenpainterswest.org/
http://www.womenpainterswest.org/
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Photographing your art work

Photographing your artwork is a must for 
todayʼs artists. Not only is it a record of your 
artwork, but crucial for submission into galleries 
and exhibitions. It is also a tool for advertising 
art. Your artwork is your calling card. Almost all 
galleries look at digital images, they do not look 
at actual artwork. WPW is requesting that all 
artists entering exhibitions have their artwork 
photographed prior to take in. 

Many of our upcoming exhibitions will require 
either photographs or jpeg images, especially 
because of travel distance to galleries. It is good 
to be prepared ahead of time. If you are looking 
for a photographer, call a board member. They 
may be able to assist you in your search. If you 
have an image, but are unable to burn a disc, 
there are several cost effective places that will 
burn a disc for you, such as Costco or 
Walgreens.

Itʼs always best to photograph your work prior 
to framing. Glass or plexiglass reflects light like 
a mirror and is not good for photographing. Basic 
guidelines for your photographed artwork are: 

1. Images should have proper representation of 
actual color. Avoid photographing your artwork 
near objects or walls with intense color that 
would reflect into your image. Neutral 
backgrounds work best.

2. When photographing, proper light exposure is 
critical. If you do not have professional lighting 
equipment, then try to photograph your work 
in natural sunlight. Bright sunlight is not best, 
however. Generally, early morning or before 
dusk, helps to avoid unwanted shadows, glare, 
or white-spots.

3. Images should be lined up properly, so that   
    square or rectangular artwork remains square 
    or rectangular of the image. Make sure your 
    artwork is flat against a surface and level. 

Work should be photographed with a tripod, 
but If you do not have a tripod, stabilize the 
camera the best as can. Try putting your 
elbows on a table or a chair-back to help 
stabilize the camera. Check your viewfinder 
before snapping the photo, to assure that you 
are lined up correctly. 

4. Insignificant background behind the artwork 
should be cropped out. 

Most digital cameras take jpegs by default. 
Use the highest resolution setting and the 
largest photo size when setting your camera. 
When photographing art, turn off your flash. It 
will create hot spots. File size can be reduced 
after the photo is taken to meet submission 
standards. Working from a larger file is always 
better than working from a smaller, lower 
resolution file. You will have a better quality 
image. Working from a smaller file will cause a 
decrease in quality of the image when making 
it larger. 

As professional artists, we should be 
representing our artwork in a professional 
manner. Not only should the art be prepared 
properly for hanging standards, we should be 
keeping archive images of our artwork. WPW

                                            Donna Geist Buch
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DIGITAL IMAGE PROCESSING FOR 
EXHIBITiON SUBMISSIONS

To help you prepare your digital images for 
submitting exhibition entries, here are step-
by-step instructions to follow for Photoshop 
Elements specifically, but the process applies 
to other digital photo editing software systems.

Photographing a work of art for 
digital processing

A good quality digital image of your work is best 
taken without flash in open shade or direct sunlight 
with no shadows, and definitely not through glass.

Use a level to align both the painting and the 
camera horizontally/vertically. Also position the 
lens with the center of the painting to avoid 
parallax distortions that occur when the surface 
plane of the picture and the cameraʼs imaging 
plane are not parallel. Use a tripod or steady 
the camera on a railing, etc., especially with 
cameras that do not instantly take the picture 
when you hit the button. While digital cameras 
seldom blur an image due to movement, hand 
held images are sometimes askew. 

For more helpful information, refer to the article, 
Photographing your art work, on page 4.

Submitting a digital image on a CD

IMPORT your image(s) to the computer

OPEN the file(s) from your camera card and copy 
onto your computer for digital processing in the 
software you use.

CROP the image so that only your painting is 
visible. If you choose to adjust the contrast or 
color saturation, this is the time to do it. Remember 
that your final product must closely resemble your 
painting in both value range and color saturation.

Be sure your file mode is RGB
GOTO: Image > Mode and check off RGB Color. 
Get the image to the correct size and resolution:

OPEN the Image Size dialogue box.
GOTO: Image > Resize > Image Size.
Change the resolution to 300 pixels/inch. The 
longest side of your image should be 1920 pixels, 
so which ever is longer, Width or Height, change 
that number to 1920. The other dimension will 
change accordingly.

Be sure Scale Styles, Constrain Proportions, 
and Resample Image Bicubic are all checked.
CLICK OK.

SAVE your Image

GOTO: File > Save As 
Change the File Name to comply with the 
instructions in the prospectus. It should be 
your name and the title of the painting.
File format must be JPG. Jane Doe_Title.JPG 
CLICK SAVE.

On the next screen, change the Quality to 
Maximum. In the Format Options, choose 
Baseline (Standard).
CLICK OK.

COPY your file(s) to CD

Use the Help function on your computer if you 
do not know how to do this. Make sure you have 
actually burned the CD. Take the CD out of your 
computer, put it back in and open one of the 
images on the disk to make sure the disk has 
burned correctly. If a problem, redo it.

Label your CD with your name and the title(s) 
of your painting(s). Use a CD marker, not a 
felt tip pen. Put the CD in a protective sleeve 
before mailing.

If there is no online submission, you must mail 
your entry with a completed registration form 
and your check. WPW
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WOMEN PAINTERS WEST 
BALLOT FOR THE YEAR 2012-2013 

 
Election of the 2012-2013 Officers of the Board of Directors will be held on May 10, 2012.  Please 
bring this ballot to the May meeting or send the ballot as stipulated in the following paragraph. 
 

Any Active-status member who is unable to be present at the Annual Meeting may mark her 
ballot for Officers and Art Jury members. Ballot may be mailed to the Corresponding Secretary:   

 
Donna Geist Buch 
20416 Stagg St. 

Winnetka, CA 91306 
 

All absentee ballots must be signed, enclosed in a sealed envelope which is also signed by 
the voter, and then enclosed in a second (outer) envelope for mailing or other form of delivery. 

 
 
OFFICERS OF THE BOARD OF 
 DIRECTORS 
 
Please cast one vote for each office. 
 
Co-Presidents 

   Lynn Gadal & Susan Rosman 
   ________________________ 

 
 
First Vice President/Exhibitions 

   Andrea Kichaven 
   ________________________ 

 
 
Second Vice President/Programs 

   Betzi Stein 
   ________________________ 

  
 
Recording Secretary 

  Ann Marie Ferreira  
   ________________________ 

 
 
Treasurer 

   Lois Ramirez 
   ________________________ 
 

 
Membership Chairpersons 

   Diane Karpel, Susan Gesundheit & 
      Harriett Lahana 
   ________________________ 

 
 
Corresponding Secretary 

   Donna Geist Buch 
   ________________________ 
 
 

THE ART JURY 
 
Please cast a total of five votes for five 
jury members. 
 

    Rosemary Bandes 

    Estelle Beigel 

         Janet Bothne 
  
         JoAnn Formia 
 
         Carol Kleinman 
 
           Esther Pearlman 
 
         Pat Salmons 
 
         Bonnie Sue Schwartz 
 
         Andrea Kichaven 
 
         Betzi Stein 
 
         Mara Thompson  
 
         Judith Lindenberg 
 
         Toby Salkin 
 
__________________________________
Signature (for absentee ballots only) 



WPW @ LAGUNA COLLEGE 
OF ART & DESIGN

Campus Gallery

July 3 - August 9, 2012
Gallery closed July 4 - 6

Reception
Thursday, August 2

6 - 9 pm
First Thursday Art Walk

Laguna College of Art & Design,
Campus Gallery

2222 Laguna Canyon Rd
949.376.6000

lagunacollege.edu 
Monday - Friday, 12-4 pm

•  Entry fee is $30 for one or two submitted pieces.  
    The gallery retains 25% of each piece sold.

•  Invitations for the show will be available at drop off on
    Monday, June 25.  Suki Kuss and Andrea Kichaven will 
    have invitations available.

•  At the end of the show, all participants MUST 
    pick up their artwork on Friday, August 10, 9 am - 5 pm
    at LCAD.  Artwork that is not picked up on this day will 
    be donated to a charity.

Exhibition Information
    The reception at Laguna College of Art and Design,  
    Campus Gallery will be during the First Thursday Art 
    Walk. Information: info@firstthursdaysartwalk.com.

Important Dates to Remember
    May 25 - Deadline for entries. Send enry forms, high
    resolution images on DVD or CD, along with 5” x 7” 
    photo, with title, size, medium & price to Susan   
    Gesundheit, 3720 Meadville Dr., Sherman Oaks, CA 
    91403.

    June 1 - Show juried by Gerald Brommer

    June 15 - Letter of acceptances

    June 25 - Invitations available at drop off locations

    June 25 - Bring artwork to drop off locations, 12 - 3 pm 

    July 3 - Show opens (gallery closed July 4-6)

    August 2 - Exhibition Reception, 6 - 9 pm

    August 9 - Show ends

    August 10 - Artwork MUST be picked up at Laguna 
    College of Art & Design between 9 am - 5 pm. 
    Work not picked up on this day will be donated.
    
Exhibit Chairs
    Suki Kuss
     sukimonstercat@aol.com / 818-780-2512
    Andrea Kichaven
     arubinkichaven@gmail.com / 310-475-0524

Exhibit Juror
    Gerald Brommer

Eligibility
•  Work must be your own original artwork, not done
    under an instructor’s supervision, and not exhibited 
    in any previous WPW show.

•  Work must not exceed 30” in any direction, 
    including frame.

•  Work must be wired and ready to hang.  

•  No sawtooth hangers for work larger than 14.”

•  If necessary, glass may be used on work measuring
    no more than 18” x 24” (432 sq. inches).

•  Gallery quality frames with neutral mats in good 
    condition (frames with loose canvases or chipped/ 
    damaged frames will not be accepted).

•  The artist agrees to permit WPW to reproduce the
    exhibited artwork for the purpose of limited WPW 
    publicity and documentation.

•  Commission on sales is 25%.

•  Please see Exhibitions Rules in your WPW directory,
    page 22, for the complete guidelines regarding 
    your entries.

Guidelines
•  Digital format (jpeg files). This exhibit will be juried
    by DVD or CD images, along with 5” x 7” photo only.

•  Entries must arrive no later than May 25. Send WPW
    entry form, entry fee, SASE for the return of your 
    DVD/CD, and the DVD/CD containing high resolution 
    jpgs (300 pixels/inch, 7” maximum any side). Each
    jpg must be labeled with title, size, medium, price.
    Also include a 5” x 7” print/photo of each entry.
    Send to Susie Gesundheit, 3720 Meadville Drive,
    Sherman Oaks, CA  91403.

•  The artists will receive the acceptance letter of 
    artwork by mail no later than June 15.

•  The accepted artwork must be delivered to one of the 
    designated locations on Monday, June 25, between 
    12 and 3 pm:
    Westside drop-off to Andrea Kichaven
    2370 Malcolm Ave., Los Angeles, CA 90064

    Valley drop-off to Suki Kuss
    5455 Calhoun Ave., Sherman Oaks, CA 91401

Please read this Prospectus thoroughly
DIGITAL ENTRIES ONLY

DEADLINE FOR SUBMISSION OF ENTRY:
Must be received by Friday, May 25, 2012

PROSPECTUS



# # # #

Lynn Gadal
3648 Coolidge Ave.
Los Angeles, CA 90066

Luncheon Meeting" " " May 10, 2012 at 11:30 a.m.   
At:# # # # # Monterey at Encino Glen
# # # # # 16821 Burbank Blvd.
# # # # # Encino, CA 91436

Program:# # # # Scholarship Awards Presentation
# # # # #
# # # # # # #Menu:# # # # # Caesar Salad with chicken or 
# # # # # Baked potato with steamed vegetables
     Cost:# # # # # $24 (to be paid when you check-in at the door)
Board Meeting:# # # 10:00 a.m.

Reservations must be received by 12 NOON on Friday, May 4, 2012

Please e-mail or call for reservations:
#      
# # Telephone:# # Mara Thompson (310) 399-7519  Please speak clearly
# # E-mail to:# # lunchwpw@earthlink.net

Please leave your name if you are bringing a guest(s) and please spell the name.     

Guest(s) Name(s) # # # # # # # # #

Memberʼs Name# # # # # # # # #

If you are unable to attend after making a reservation, please call Mara before the deadline, or you will be held 
financially responsible for the cost of the luncheon.
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